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©” Outlook Overview

Microsoft Outlook is a combination of mail system, calendar, contact list, to-do list and
journal. Using it you can communicate with other electronic mail users, keep a schedule of
your appointments, and coordinate with your colleagues to plan meetings. You can also keep
a list of your contacts and their details, create a 'to do' list, and post the electronic equivalent
of sticky notes on your desktop to remind you of other things you need to do.

When you're using Outlook, these items are organised into built-in groups and folders so that
it's easy for you to find and view the information that you've stored, although you can choose
to reorganise the information to suit yourself.

Initially, Outlook information is organised into three groups: Outlook Shortcuts, My
Shortcuts and Other Shortcuts (see the illustration on page 1).

The Outlook Shortcuts Group

The Outlook Shortcuts group contains a number of folders by default: one for each type of
information that can be stored. In addition to these folders, this group contains Outlook
Today, which shows you a summary of your day. It lists your tasks, appointments and any
new messages you've received.

Like the other groups, the number and type of folders shown in this group can be customised.

The My Shortcuts Group

The My Shortcuts group contains the folders where messages you create are stored. The
Drafts folder contains messages that you've started composing but have not as yet sent; the
Outbox folder stores your messages until they are sent, when they are moved to the Sent
Items folder.

The Other Shortcuts Group

The Other Shortcuts group contains folders that allow you to fast access other parts of your
computer system, such as the default location of any documents you create using Microsoft
Office programs. Each of these groups and folders is described in detail later in this
workbook.
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@ Loading Outlook

Before you can use Outlook, you have to load it. You can do this either by double clicking
the Outlook icon on your desktop, or by selecting the Start button on your taskbar and
choosing Microsoft Outlook from the Programs menu.

To Load Outlook

Double click the icon on your desktop.

outlook. exe

Alternatively, select the Start button on your taskbar then choose Microsoft Outlook from
the Programs menu:

If your computer is used by a variety of Outlook users, you may be asked to choose a user
profile. If this is the case, choose your profile from the drop-down list...

Choose Profile E

Profile Mame: |ietame AR

Diiane Marmow
Microzoft Outlook

QK I | Cancel | | Help | | Dptiokig »» |

...then click OK.

Outlook will start and the Information viewer will be displayed.
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@ The Outlook Screen Elements

The Outlook screen will resemble that shown below. However, as the screen elements can be
customised, you may find that your screen looks slightly different.

Title bar Menu bar Standard toolbar Unread message Folder banner

& Inbox - Microsoft Outliok -0l x|

J File Edit Wiew Favorites Tools Actions Help
| .
Jﬁew - @ | b | ¢ Reply @Replv to Al W€ Forward | %Sendeeg&ive | E@Fi_nd <3{':gOrganige L d | | E =

Cutlook Shortouts

«

|Subject |Received

t| [1|%|g|From

% 0 Peter Connolly Fu's Merry Christmas! —  Wed28/11J2001 16:49
] 0 David Elder Fuw': Tender wed 28/11/2001 14:20
] Ewan McGhes M8 Project - Content For Phase 1 wed 28/11/2001 1413
] karen. colier@quintiles. com Re: powerpoint wed 28/11/2001 1353
] info@barnesandnobleuniver, ., Barnes and Moble University wed 28/11/2001 11:33
] info@barnesandnobleuniver. ., Barnes and Moble University wed 28/11/2001 11,23
=] Paul Brennan RE: Mew PCs whed 28/11/2001 10:13
-~ @ 1] Clydeport Training Session Schedule Tue 2701172001 16:47
elendr £ O David Stephen RE: ClydeNET Handbook Tue 27/11/2001 16:30
E=N 21 0@ Geraldine Denny Tue 27011/2001 15:39 j
EE‘ From::  FPhyliis Drake To: Phyllis Crake
Subject: MOUS Cc:

| v

http://wuw.certiport.dom/ iQecenters/marketingResourceLibrary/

Mb Shartouts By checking this Web Jite you will find additional finformation that will
Otther Shortcuts | |P5LF .
= Shartodts Support your cowmpanigs efforts in promoting and rafising the awareness of
[Calendars Microsoft Office User |[Specialist (MOUS)
eh Sites j
|191 tems, 3 Unread
Outlook bar Information viewer Read message

Title Bar

The title bar displays the name of the folder that you're currently viewing in Outlook and the
name of the application. At the right side of the title bar are the standard Windows buttons
for minimising, restoring/maximising, and closing the application window.

Menu Bar

The menu bar contains a list of menu names each of which, when selected, will display a list
of related options. You can display menu options either by clicking on the menu name on the
menu bar or by holding down the [ALT] key on the keyboard and pressing the letter that's
underlined in the menu name, e.g. to access the Edit menu options, you'd hold down the
[ALT] key then press E. You can also select an option from a displayed menu using either of
these methods. The menu names that appear will vary, depending on what you're doing at the
time.
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@ The Outlook Screen Elements

Standard Toolbar

The Standard toolbar contains buttons that you click to carry out particular Outlook
operations. The buttons that appear on the toolbar will vary according to what you're doing at
the time. To find out what any button does, rest the mouse pointer on it for a few moments
and a ScreenTip will be displayed:

& Inbox - Microsoft Outlook -0l =l

J File Edit Yiew Favaorites Tools Ackions Help |
Jﬂew - | &b | s X | CyReply €8 Reply to Al G Forward | = send/Receive | EoFind %porganize ¥ | - | 3@ .

1
(ompesoc

I
The More Buttons button

Customising Menu Bars and Toolbars

Both menu bars and toolbars can be customised to suit the user's own preferences. For
example, if there's a particular menu option that you use regularly, you can add any available
button representing it to a toolbar. Click the More Buttons button to see a list of icons. If
the one you want doesn't appear on the list, choose Customize and then locate the button you
want. To remove a button, display the Customize dialogue box then drag the button off the
toolbar.

To add an option a menu bar, select the View, Toolbars, Customize menu option and drag
the required option from the Commands sheet to the menu it is to appear on. To remove a
menu option, display the Customize dialogue box and drag the option from the menu it
currently appears on.

Folder Banner

The folder banner displays the name of the open folder. Click the folder name in the banner
to display a list of folders: /..

Click DUSth}‘I to keep open -N| |Received & I;

@ Microsaoft Mal Shared Folders S5a0e Wed 23/09/9...

' @ Outlook Today - [Personal Folders] fourses For IT Training Suite Tue 22/09/98...

-4 Calendar ustrentt Tue 01/09/98...

@ Cortacts ning Programme., Tue 01/09/98...

#-3 Deleted ltems ning Programme. Tue 01/03/93...

4B} Drafts ssage Tue 01/09/98...

) ccage Tue 01/09/28...
‘#ﬁ::;al ssage Tue 01)09/98...

Calendar 78 Outhox . wed 13/05S..
TN Sert ltems [ Sales Meeting 135 Mon 17[08/95... j

‘% @ Tasks To: delder; gdenny; kareen; Ihendersan; Ipaterson; mchapman; melder
2 Cc:

call Jirn White on 0141 204 8338, re pack he received this =
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@ The Outlook Screen Elements

../ Folder Banner

You can view the contents of any of these folders in the Information viewer by clicking its
name in the folder list. If however you want to carry out any other operation on the folder,
e.g. to copy it or move it, you must click the pushpin shown at the top of the list so that this
pane remains open. To move an item from one folder to another, display its original folder
and then drag the item to the new folder.

Outlook Bar

The Outlook bar contains the three Outlook groups: Outlook Shortcuts, My Shortcuts and
Other Shortcuts. The folders that are part of the selected group are shown in the Outlook
bar. In the illustration on the left below, the folders from the Outlook Shortcuts group are
listed. To display the folders from one of the other groups, click on the group name:

Outlook Shartcuts Outlook Shortcuts

A ? ty Shortcuts
Outlook Today @

e Drrafts
<
S
Inbos @
- Outhox
Calendar
e Sent ltems
Contacts
Tasks
D =
ty Sharteuts )
Other Shartcuts Other Shortcuts
Click here to see the contents of the My Shortcuts group... ...in the Outlook bar.

Information Viewer

The contents of the current folder will be shown in the Information viewer.

Changing the Appearance of the Current Folder

The appearance of your folder contents in the Information viewer can be customised using
the View, Current View menu. For example, if the Calendar is currently displayed in the
Information viewer, you can choose to view it a day, week, work week, or month a time;
when the Contacts folder is displayed you can choose from a number of different layouts for
your contact details, and so on. The options available on the View, Current View menu will
depend on which folder is currently displayed in the Information viewer.
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==  Exercise 1-1

1. Load Outlook using one of the methods described earlier.

The Outlook screen is displayed. The contents of the default folder are shown in the
Information viewer. Initially this will be Outlook Today, however, you can change this
setting if you want to.

2. Take a few minutes to examine the Outlook screen.

Notice that the Outlook Shortcuts group folders are listed in the Outlook bar at the left of
the screen. Depending on the size of your screen, you may not be able to see all the
folders. In this case, an arrow shown at the bottom of the Outlook bar can be used to view
the others.

Tasks

& You can click here to see the other
Joumal 7 folders in the group.

3. Click on the Inbox folder in the Outlook bar.

The contents of your Inbox are shown in the Information viewer. If this is the first time
that you've loaded Outlook, a welcome message will be displayed.

Outlook Sharkeuts | 1] sTebes ]

4 4| [ %] @] From |Gubect |Receivad T

@ | % tmassabo Phone Message

Dutlook, Today =] pronnolly Training Courses for IT Training Suite Tue 22/09/98. .,

i lhenderson Payroll Adjustment Tue 0170998, .,

@ [ peannolly Sales Training Programme. Tue 01709798, ..

= ) peannally Sales Training Programme. Tue 0109195,

Inboz (1] =] tmas sabo Phaone Message Tue 01/09/38...

4. Click on the Tasks folder in the Outlook bar.

Any tasks that you've been assigned are shown in the Information viewer. If this is the
first time you've loaded Outlook, a sample task will be displayed.

5. Select the View, Current View, Detailed List menu option to display additional
information relating to your tasks.

6. Select the View, Current View, Simple List menu option to return to the default view for
the Tasks folder.
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==  Exercise 1-1

7. Click on the My Shortcuts group in the Outlook bar.

Outlook
Hail

Inbiox

Sent ltems

S

Outbox

Deleted ltems

Folders relating to your sent mail are now shown in the Outlook bar.

8. Click on the Other Shortcuts group.

Outlook
tail
Other

=]

by Computer

L

My Docurment:

=)

Favorites

Public: Folders

From this group you can access other parts of your computer system. Note, however, that
the precise contents of this group will depend on the setup that your own system uses.

Microsoft Outlook 2000 Introductory Course e Student Workbook e © 2000 e www.StudylIT.net
1-8



@ Using Help

Outlook has a comprehensive on-line help system that you can use when you want to know
more about a particular option or how to complete a task. Described below are some of the
ways you can get help.

What’s This?

Using the Help, What’s This? menu option you can ask Outlook to display a description of
parts of the screen and in some dialogue boxes. When you choose this command, the mouse

pointer changes to (¥ Click on the item you want a description of.

The Office Assistant

The Office Assistant provides tips on how to get the best from Outlook and provides
step-by-step instructions to guide you through specific tasks. It anticipates the kind of help
you need and suggests Help topics based on the work you're doing. It will also answer Help
requests typed in your own words.

If you need help from the Office Assistant, click on the Z)| button or select the Help,
Microsoft Outlook Help command and then type your question.

The Office Assistant will display a choice of help topics for you to choose from. Click on the
one you want and help will be displayed.

-
wWhat would you like to do?

¢ About syrbols in Microsoft
Cutlook

¢ Create new items from
different types of items

¢ Move messages
¢ Standard views

¢ Set up where and how e-mail
messages are delivered

W See more...

Options
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Using Help

When you choose a topic on which you want help, the Microsoft Outlook Help window will

be displayed.

_'3 Microzoft Outlook Help

e = B

Preview items

You can preview the first three lines of messages,
or set up the screen so that the contents of any
itern, including messages, appear in a preview
pane. If you use the preview pane, you can select
optians to rmark messages as read, use the
SPACEBAR to move between messages, and change
the font used in the divider,

vou cannot edit the content of messages in the
preview pane.

What do you want to do?
Display or hide the first three lines of messages.

Display or hide the preview pane.,

Set options for reading messages with the preview
pane

additional resources

Microsoft Outlook Help

R =

Click here to
display this help
topic.

Preview the first three lines of
messages

1. Click Inbox S .

2. To display or hide the first three lines of a
message under the message, click the Yiew
menu, and then click AutoPreview,

Note To preview the first three lines of unread
messages only, click the Yiew menu, point to
Current ¥iew, click Customize Current ¥iew,
click Other Settings, and then click Preview
unread items,

additional resources
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@ Using Help

Using Contents, Answer Wizard and Index

By expanding the Microsoft Outlook Help window you can use the Contents, Answer
Wizard or Index facility to find the help you’re looking for:

2 Microsoft Outlook Help

e o B

Conterts | . . .
= answer Wizard | index | Preview the first three lines of

2] Outlook features available when you messages

@ Schedule an Online Meeting with Mic I
@ Managing % our Messages 1. Click Inbox \,\ .
@ Managing “our Inbax with Rules
@ IJzing Remaote Mail to Manage our b 2, To display or hide the first three_ lines of a
@ Uising Offline Folders to Manage o rmessage under th,a rmessage, click the Yiew
@ Using the Address Book renu, and then click AutoPreview.
@ Ising Internet E-mail Mote To preview the first three lines of unread

@ Wiorking with Forms and Folders messages _u:unlyr, u:I_lu:k the '!'iE-'l.':! rmenu, point t_u:u

@ Using Public Folders l:l_.lrrent Yiew, u:_llu:k Customize l_:urrent _'lll'lew,
) click Other Settings, and then click Preview

@ Using Delegate Access unread items.

@ Uszing Security Features

@ Izing Information Services and User

additional resources

To use Contents double click the relevant heading to see its subheadings until the help you
want is displayed in the right pane of the window.

To use the Answer Wizard type your question into the box...

Anzwer Wizard | nex

What wauld wau like ko do?

how do I open a message?|

...then click the Search button. /..
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@ Using Help

../ Using Contents, Answer Wizard and Index

A list of related topics will be displayed. Click the one you need to display the help
information in the right pane:

Ansyver Wizard
Contents = |'-“‘"3-‘*c | Open a message

What would yaou like ko do?

1. Click Inbox \%\ .

Z. Inthe message list, double-click the message
you want.,

Additional resources

Y

Open messages and go ko the next ¢
Mark a message as private, personal

Select topic to display:

To use the Index type a key word into the text box. As you type, topics beginning with the
characters you type will be shown in the list box: /..

Ql:untentsl Answeer Wizarg  ndex

1. Tvpe kevwords

Clear | Search I

|save|

2. 0r choose keywords

Save_As

srale

sCan

SCenario =
schedule

scheduler ;I
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@ Using Help

../ Using Contents, Answer Wizard and Index

Click Search to find a list of help topics that include the word(s) you typed or the word(s)
you selected from the list of keywords:

2 Microsoft Dutlook Help
& 5 S
Y
Inclesx | —I
Contents I Ansywer Wizard Save messages
1. Tvpe kevywords
L=y What do you want to do?
save )
I Turn on or off saving a copy of messages you
Clear | send.
Zave an unfinished message.
2. Or choose keywords Save an itern as a file,
E;, ﬂ Additional resources
(=]
+{operator)
it
£
¥
< =
3. Choose a kopic (154 Found)
Save MEessages
Save an appaintment in Inkernet (iC2
Zhange where personal addresses al
Turn on Aukobrchive
Save a Calendar as a WWeb page
Save search criteria
Create a backup copy of a Falder
Store another person's freefbusy inf
Save conkack information for use on |
Turn on or off saving a copy of mess;l LI

You can use the Back and Forward buttons at the top of the window to revisit help pages
you’ve previously seen during this use of the Help system.

Back Forward

||
T < > SO

g:untentsl ArEwer Wizard  Index | |
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==  Exercise 1-2

1. Follow the instructions below to get help on create a mail message.
— Select the Help, Microsoft Outlook Help command.
The Office Assistant is displayed.
— Type Create a Message and click Search.
The Office Assistant presents you with a list of topics.

s =y
what would you like to do?
® Create a message

@ Create a new message
Lging stationery

@ Create a personal folder

@ Delay delivery of a
message

@ Japanese and English
headers

W See more...

HIMicrozoft Outlook Help

Create a message
1. ©n the File menu, point to New, and then click
Mail Message,

2. Enter recipient names in the To, Cc, and Bec
boxes,

To select recipient narmes from a list, click the
To, Cc, or B button,

3. Inthe Subject box, type the subject of the
message.

4, Inthe text box, type the message.

5. Click Send [ =,

MNote For information about how to create a
message that uses stationery, click 2,

Additional resources

[

— Once you have read the help text, expand the Help window by clicking the button
at the top.
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==  Exercise 1-2

2. Follow the instructions below to get help using the help Index.
— Display the Index property sheet then type create.
— Click Search.
A list of topics relating to create items is displayed.

Contents I Anzwer Wizard  Index |

1. Twpe keswords

Clear | Seatch I

2. Or choose keywords

|_operator ﬂ
#

$

OI"IO
*(operatar)
@
+{operatar) LI

Icreate

3. Choose a kopic {412 found)

Create a public Folder

Create a message

Create a bask

Create a noke

Set up LDAP direckory services

Add a personal Folder file ko & user pi
Create a filker for an Offline Folder
Create a new message Using skatione
Set up security For Internet message
Add a Personal Address Book ko & us ¥

— Click Create a task to display this help information in the right pane of the Help
window.

Create a task

A task is a personal or wark-related errand you
want to track through completion. & task can ocour
once or repeatedly (a recurring task). A recurring
task can repeat at regular intervals or repeat based
on the date vou mark the task complete. For
example, vou might want to send a status report to
your manager on the last Friday of every month,
and get a haircut when one month has passed since
your last haircut,

Recurring tasks are added one at a time to the task
list, when yvou mark one occurrence of the task
cornplete, the next ocourrence appears in the list,

What do you want to do?

Create a task that occurs once

Create a task that recurs at reqular intervals

Create a task that recurs based on completion date

Additional resources

— Read through this information.
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Exercise 1-2

3. Follow the instructions below to use the Answer Wizard property sheet to get help.

— Display the Answer Wizard property sheet.

— Type how can I hide the Office Assistant into the text box.

A list of topics containing what you've typed is displayed in the right pane.

Microsoft Dutlook Help

ERG =

Contents  &nswer Wizard Ilndex |

What would you like to do?

splay b es through the ¢
Mark a message as private, personal, or
Hide private appaintment details when p
Turn the OFfice Assistant sound on or of

Select topic ko display:

Display tips and messages through
the Office Assistant

What do you want to do?
Hide, show, or turn off the Office Assistant

Turn on or turn off sutomatic display of Help topics
by the Office Assistant

Turn on_or turn off Office Assistant Help with
wizards

Cisplay messages with or without the Office
Assistant

Troubleshoot the Office Assistant Show the Tip of the Day when Outlook starts
Ways ko get assistance while you work
Select a different Office Assistant
Languages supported by the Answer Wi
Show or hide a toolbar

Show ar hide the Outlook Bar

Show or hide koolbar ScreenTips

Show or hide the status bar

Show or hide empty figlds in a card view
Show week numbers in Date Mavigator
Shaw ar hide the Bee field in & message
Show the names in a personal distributio
Close print preview

Show or hide folders

Show ar hide the itermn label when viewin
Mark messages as read or unread

Mot sure which choice you want?
Additional resources

— Click Hide, show or turn off the Office Assistant.

Hide, show, or turn off the Office
Assistant

You can termpararily hide or show the Office
Assistant while you're working in Microsoft Outlook.
You can also turn off the Office Assistant and use

only the Help window. How to get Help without the
Office Assistant,

Temporarily hide or show the Office
Assistant

e« 0Onthe Help menu, click Hide the oOffice
Assistant or Show the Office Assistant.

Turn off the Office Assistant
1. Inthe Assistant balloon, click Options.

If the Assistant balloon isn't visible, click the
Assistant.

2. Onthe Options tab, clear the Use the Office
Assistant check box,

Tip Toturn on the Assistant at any time, click
Show the Office Assistant on the Help menu.

MNote “You can remaove the Assistant permanently
by rerunning Cutlook Setup.

additional resources

— Read through this information and then close the Help window by clicking its
Close button.
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@ Questions and Answers

1. What folders are listed in your My Documents group in the Outlook bar?

2. What's shown in the folder banner?

3. What's shown in the Information viewer?

4. Which menu option displays the Office Assistant?

Microsoft Outlook 2000 Introductory Course e Student Workbook e © 2000 e www.StudylIT.net
1-17



A
Z Index

A
Answer Wizard, 1-11

Cc

Contents
help, 1-11

F
Folder Banner, 1-5

G
Getting Help, 1-9

H
Help, 1-9

contents, 1-Answer Wizard and

index, 1-11

Office Assistant, 1-9

|
Index, 1-11

Information Viewer, 1-6

L
Loading Outlook, 1-3

M

Menu Bar, 1-5
My Shortcuts Group, 1-2

o)

Office Assistant, 1-9
Other Shortcuts Group, 1-2
Outlook
explained, 1-2
loading, 1-3
Outlook Bar, 1-6
Outlook Shortcuts Group, 1-2

S

Screen Elements, 1-4
Standard Toolbar, 1-5
Starting Outlook, 1-3

T

Title Bar, 1-4
Toolbars, 1-5

N<Xs<Cc-H0WVWIOoTvTOZ=Z2=rn=x«Gc—-IT60mMmMmOO®>»

Microsoft Outlook 2000 Introductory Course e Student Workbook e © 2000 e www.StudylIT.net

1-18



Microsoft Outlook 2000 Introductory Course e Student Workbook e © 2000 e www.StudylIT.net
1-19



Microsoft Outlook 2000 Introductory Course e Student Workbook e © 2000 e www.StudylIT.net
1-20



	Table of Contents
	Outlook overview
	Loading Outlook
	The screen elements
	Using help
	Index

